d' Power BI

This cheat sheet provides a quick reference for
essential Power Bl features and functionalities,
helping you analyze data, create interactive reports,
and design insightful dashboards with ease. It covers
a wide range of categories, including data
interaction, transformation, modeling, analytics,
visualization, and workspace, ensuring you have the
tools needed to perform tasks from basic data
exploration to advanced scenario modeling.

Each entry includes clear syntax and concise
explanations, paired with practical examples to
demonstrate how the feature operates in real-world
scenarios. Whether you’re writing DAX formulas,
transforming or designing semantic models, or
creating advanced visualizations, this cheat sheet
simplifies Power Bl’s robust capabilities.

Designed to be accessible and actionable, this
resource is perfect for professionals, students, and
business analysts looking to improve their efficiency
and confidence in Power BI. Keep it handy for quick
guidance on Power BlI’s versatile functionality.
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f« DAX Functions

Syntax for

CALCULATE

SUM

AVERAGE

TOTALYTD

LASTDATE

PATH

USERELATION-

SHIP

CALENDAR

DATAQUEST

How to use

CALCULATE (Expression,

SUM(Table[Column])

Filters)

AVERAGE (Table[Column])

TOTALYTD(Table[Column])

LASTDATE (Dates[Column])

PATH(Table[Child_Column],

Table[Parent_Column])

USERELATIONSHIP(Tablel[Columnl],

Table2[Column2])

CALENDAR (START_DATE,

END_DATE)

Power Bl Cheat Sheet

Explained

Modifies the filter context of an
expression, enabling advanced
calculations like conditional totals
or time intelligence analysis.

Adds all numerical valuesin a
column, commonly used in
measures.

Calculates the average of a
column's numerical values.

Calculates the Year-To-Date total
for an expression.

Returns the last date in a given date
column, often used in semi-
additive measures.

Creates a string that shows the
hierarchical path from a parent to a
child.

Activates an inactive relationship
between two tables for a specific
calculation.

Generates a continuous range of
dates between two specified dates.

Syntax for

CALENDARAUTO

RELATED

CONCATENATE

DIVIDE

DISTINCTCOUNT

RANKX

How to use

CALENDARAUTO ()

RELATED(Table[Column])

CONCATENATE (Valuel, Value2)

DIVIDE (Numerator, Denominator,

AlternateResult)

IF(Condition, TrueResult,
FalseResult)

DISTINCTCOUNT (Table[Column])

RANKX(Table, Expression, Value,

Order, Ties)

Explained

Automatically creates a date table
based on the minimum and
maximum values of date columns
in the model.

Retrieves a related value from
another table using an existing
relationship.

Combines two values into a single
text string.

Performs division while handling
divide-by-zero errors gracefully by
returning an alternate result.

Evaluates a condition and returns
different results based on whether
the condition is true or false.

Counts the number of unique
valuesin a column.

Returns the rank of avaluein a
table based on an expression, with
options for handling ties.




f« DAX Functions

Syntax for How to use Explained Syntax for How to use Explained

SWITCH SWITCH(Expression, Valuel, Resultl, Evaluates an expression and MAX MAX (Table[Column]) Returns the largest numeric value
returns a matching result for the in a column.
[Value2, Result2], ...,

first case.

[ElseResult]) .
MIN MIN(Table[Column]) Returns the smallest numeric value
in a column.

FORMAT FORMAT (Value, FormatString) hormatsiavaluielasalstingiusinga

specified format (e.g., currenc i
P (e.g., Y, COUNTROWS COUNTROWS (Table) Counts the number of rows in a
percentage). table.

Returns a single-column table with
unique values from the specified
column.

Groups data by specified columns
and calculates aggregated values.

VALUES VALUES (Table[Column]) SUMMARIZE SUMMARIZE (Table, GroupByColumnName,

[Name, Expression], ...)

Refers to a row context in an earlier

EARLIER EARLIER(Column, Offset) ) ) ]
’ iteration of the same calculation. LOOKUPVALUE LOOKUPVALUE (Result_Column,

Returns the value of a result
column based on search criteria.

Search_Column, Search_Value,
[Search_Column2, Search_Value2])

ISBLANK ISBLANK (Value) Returr.15 TRUE if the specified
value is blank.

Rounds a number to the specified
number of digits.

Removes all filters except those

ALLEXCEPT ALLEXCEPT(Table, Columnl, Column2, ) .
applied to the specified columns.

.)

Returns a table that contains only

rows matching a specified
condition. ROUND ROUND (Number, NumDigits)

FILTER FILTER(Table, Condition)

ALL ALL(Table[Column]) Removes all fllt.ers from a table or
column, returning all rows.
Returns TRUE if the column
contains only one distinct value in
the current filter context.

HASONEVALUE HASONEVALUE (Table[Column])
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DAX Operators

Syntax for

Addition (+)

Subtraction (-)

Multiplication (*)

How to use

Sales[Amount] + Sales|[Tax]

Sales[Amount] - Sales[Discount]

Sales[Price] * Sales[Quantity]

Explained

Adds two numerical values or
columns.

Subtracts one numerical value or
column from another.

Multiplies two numerical values or

Syntax for

Less Than (<)

Greater Than
or Equal (>=)

Less Than or

How to use

Sales[Price] < 100

Sales[Price] >= 100

Sales[Price] <= 100

Explained

Checks if one value is less than
another.

Checks if one value is greater than
or equal to another.

Checks if one value is less than or

columns. Equal (<=) equal to another.
Division (/) Sales[Total] / Sales[Units] D|\l/|des c;)ne nu:;]erlcal value or Logical AND (Sales[Price] > 100) && Returns TRUE if both conditions are
column by another. .
y (&&) (Sales[Units] > 10) e
Exponentiation [ EANTEED Ralste;\s a numl;er to the power of
another number. i
(A) Logical OR (||) (Sales[Price] > 100) || RetUﬂﬁiTRUElfatleastone
. condition is true.
Combines two text strings into one (Sales[Units] > 16)
Concatenation Customer[FirstName] & " " & )
(&) Customer[LastName]
Logical NOT NOT (Sales[Category] = Reverse.s the_rllgg:EC:l \Ilzil:_'lseEOf ag )
(NOT) "Electronics™) expression ( o) and vice
Equal To (=) Sales[Category] = "Electronics" Compares two values for equality. versa).
Inclusion (IN) Sales[Category] IN {"Electronics", Checks if a value exists in a

Compares two values for

Not Equal To Sales[Category] <> "Electronics" ) .
inequality.

(<)

"Books"} specified list of values.

Checks if one value is greater than

Greater Than (>) Sales[Price] > 100
another.
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DAX Operators

Syntax for

Parenthesis

(0)

Table
Constructor

({h

Equality for
Relationships

(=)

DATAQUEST

How to use

(Sales[Price] * Sales[Units]) +
Sales[Tax]

Customer[ID]

= Sales[CustomerID]

Power Bl Cheat Sheet

Explained

Groups expressions or specifies the
order of operations in calculations.

Creates a table with a single
column containing the listed
values.

Creates relationships between
tables based on key columns.

(@ Data Interaction

Syntax for How to use
Power Bl Connect to data
Workflows Transform and model data
Create visualizations
Publish and share
Connect to
Data > Get data
> Select File Type (e.g.,
CSV, Excel)
> Open File
> Load or Transform Data
Data > Home

Transformation > Transform Data

> Use Power Query
Editor

Publish File
Reports Publish
Power BI Service

Manage Transform Data
Data Data Source Settings
Sources Change Source

Transform
datawv

Transform
data~

Explained

Workflow includes importing data
from sources like Excel or CSV,
transforming data in Power Query
Editor, building reports, and sharing
insights via Power Bl Service.

Easily connect to various data
sources like Excel, CSV, XML, or
databases, and load them into
Power Bl for further processing.

Clean and shape your data, such as
renaming columns, filtering rows,
and changing data types, to
prepare it for analysis.

Share your reports with others by
publishing them to Power Bl
Service, where dashboards and
access can be managed.

Update data source paths or
settings to maintain the accuracy of
your reports when file locations
change.




2o Data Modeling

Syntax for

View Model
Layout

Create
Relationships

Autodetect
Relationships

Mark a Table as

a Date Table

DATAQUEST

How to use

Home Tab
Model view
View Diagram

Modeling Tab
Manage Relationships

New
Choose Columns
Define Cardinality

Modeling Tab
Manage Relationships
Autodetect

Data Pane
Right-click Table
Mark as Date Table
Select Date Column

Power Bl Cheat Sheet

Manage
relationships

Manage
relationships

~

siafi4 A

A

SUCIEZI[ENSIA

Explained

Allows managing table
relationships, creating measures,
and organizing data for effective
data modeling,.

Establish connections between
tables using key columns, defining
cardinality (e.g., many-to-one, one-
to-one).

Automatically identifies and
creates relationships between
tables based on column names and
data types.

Assigns a table as the primary date
table, ensuring accurate time-
based calculations and filtering.

Syntax for

Create DAX
Measures

Create DAX
Calculated
Columns

Hierarchies in
Dimension
Tables

Manage
Cardinality

How to use

>
>
>
>

Data Pane
Right-click
New Measure

A

suonezijensip

Data Pane
Right-click

/R
A

s A

New Column
Enter DAX Formula

suoneziensip

Data Pane
Right-click
New Hierarchy

A
~

s A

suonezijensip

Modeling Tab
Manage Relationships Manage
relationzships

New
Define Cardinality

(e.g., Many-to-One, One-

to-Many)

Explained

Use DAX to calculate values like
sums, averages, or percentages,
enabling dynamic and reusable
calculations.

Add new columns derived from
existing ones, materialized into the
dataset, increasing file size.

Organize columns (e.g., Year >
Month > Day) into a hierarchy for
drill-down capabilities in
visualizations.

Adjusts how tables relate to each
other (e.g., many-to-many for
flexible connections).




2o Data Modeling

Syntax for

Flatten
Hierarchies

Performance
Optimization

Aggregation
Columns

Bidirectional
Cross-Filtering

Enable Auto
Date/Time

How to use

> Model Tab
> View D1

> Select Flattened Table

Option

agram

o=

Diagram

View v

Explained

Breaks down hierarchical
relationships into a single-level
table for simpler analysis.

Note: Diagram view is only available in Power Query Online.

View Ta
Perform

Power Q

b
ance Analyzer

uery Editor

Group By

Add Agg

> Manage
> Enable
Filtering

File
Options
Data Lo

Auto Date/Time for New

regation

Relationships
Bi-Directional

ad

Power Bl Cheat Sheet

Manage

relationships

Sign in

Options and
setfings

About

Analyzes report performance,
identifying areas for improvement
like visuals or DAX queries.

Pre-aggregate data by grouping
and summarizing at desired levels
of detail.

Allows filters to flow both ways in
relationships, ensuring
comprehensive filtering.

Automatically generates date
hierarchies for date columns,
simplifying time-based analysis.

Syntax for

Create Quick
Measures

Concatenate
Columns

Circular
Relationship
Detection

Use
Aggregation
Manager

How to use

Data Pane
Right-click

New Quick Measure

Power Query Editor

Add Column

Custom Column

Define Concatenation Formula

Model Tab
Analyze Relationships
Resolve Circular References

Data Pane
Right-click Table
Manage Aggregations

A

suonezijensip

A

suonezijensip

Explained

Generate commonly used
calculations like totals or averages
without writing DAX.

Combine multiple columnsinto a
single column (e.g., concatenating
Year and Month to create
"MonthYear").

Identifies and resolves circular
dependencies in relationships to
avoid calculation errors.

Defines pre-aggregations for tables,
improving performance when
querying large datasets.




@ Power Bl Visuals and Analytics

Syntax for How to use Explained Syntax for How to use Explained
Add Visuals > Visualizations Pane Allows adding visuals such as Sorting Data > More Options (Three Dots) Organizes data logically,
> Select Visual Icon (e.g., ¢ tables, bar charts, line charts, etc., > Sort Ascending/Descending highlighting the most relevant
Table, Chart) 3 to represent data insights or By Field information without removing any.
g effectively.
Tooltips > Format Pane Visualizations Adds customized hover-over Filters > Drag Fields to Filter Pane Removes unnecessary data,
> Tooltip Section = descriptions for enhanced data > Configure Filters o s enabling focus on relevant

context in visuals. information in reports.

I A

> Configure Custom Tooltip

suoneziensip

Conditional > Format Pane Visualizations SpeCifieS cell COlorS, data bars, KPI Background > Format Pane Visualizations Adds visual elements like colors or

= icons, or web links based on field and Borders > Background/Border = borders to highlight and isolate
values. Sections | specific visuals on the canvas.

> Configure Color or Image

Formatting > Conditional Formatting
Options

Add Slicer > Visualizations Pane Adds a slicer to filter data Drillthrough > Add Drillthrough Fields (= Allows users to navigate to detailed
s Slicer Icon « « interactively by specific criteria > Configure Target Page e pages for in-depth analysis by
> Drag Fields to Slicer 2 (e.g., year or region). Market Basket Ansl clicking on a specific field or value.

suolnezijensip

Visualization
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@ Power Bl Visuals and Analytics

Syntax for How to use Explained Syntax for How to use Explained

Bookmarks View Tab Saves the current view of a report Add Alt Text Format Pane Miuslicsions Ensures accessibility by providing
Bookmarks page for quick access, enhancing General Section e descriptions for visuals that screen
Add Bookmark navigation and storytelling. Alt Text readers can interpret.

Enter Description

: : Key Visualizations Pane Tracks performance against a
Buttons > Insert Tab a Adds interactive bl.th.tons for Performance KPT Icon « target using metrics, goals, and
> Buttons navigation or specific actionsin a Indicators sdk elne, Gesl, amd e 3 timelines (e.g., total sales vs. sales
> Add Button report. (KPIs) Erame g target).
> Configure Action
(e.g., Page Navigation)
Clustering Scatter Chart Analyzes and groups similar data
More Options points in a scatter chart based on
Allgn and CTRL + C-L-i Ck V-i Suals Visualizations Allgns and evenly diStrIbUteS Automati Ca-l.-l.y F1' nd C'Luste rs attribute ValueS.
Distribute Format Tab s~ visuals on the canvas for a clean,
Visuals Align/Distribute Options professional layout.
Top N Analysis Filters Pane Visualizations Displays the top N records based
Field e on a selected value (e.g., Top 10
=l Tyee — selling products).
: : : Top N
Hierarchy > Data Pane Groups data into hierarchical levels

A
=

(e.g., Year > Month > Day) for drill-

> Drag Fields to Create
down capabilities.

s A

Hierarchy

suonezijensip
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@ Power Bl Visuals and Analytics

Syntax for How to use Explained Syntax for How to use Explained
Histograms I _
and Bell Use Column Charts for Histograms; R.epr.esel?ts Stat's_tlc_aldat.a Decomposi- > Visualizations Pane Allows data exploration across
curves Use Area Charts for Bell Curves distributions for insights into data tion Tree > Decomposition Tree Icon B multiple dimensions, providing
patterns. > Add Fields to Analyze and 7 insights into high and low values in
Explain s hierarchical data.
Ana[yze > R-ight—cljck Visual Data PrOV|deSAI'generated|nS|ghtS|ntO
Feature EEui why data has changed or its
> Analyze distribution differences. Q&A Visual Double-Click Canvas Uses natural language processing
Increase or Distribution related questions.
Differences)
. . . Statistical Visualizations Pane Provides quick descriptive statistics
Al Insights > Power Query Editor Applies pretrained machine ] <5 : TR
o learning models for tasks like Summary Add Summary Visual o like averages, distributions, and
> e Geeann Tels ) L z § clusters for high-level insights.
> Select Text Analytics, sentiment analysis, image g
Vision. or Azure Machine processing, or anomaly detection. -
)
Learning
Advanced Visualizations Pane Imports specialized visuals from
q ¢ q s f H Analytics Get More Visuals “5 Microsoft AppSource for complex
' ' - Identifies and ranks factors that . <5 -
Key 2 AL SIS AT , o o Visuals Select Advanced Analytics F E analytical needs.
Influencers > Key Influencers Icon B influence a specific metric, aiding e —— "z
Visual > Add Metric to Analyze and : in root cause analysis. s )

suoHeZI[eNSIA

Dimensions to Explain By
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@ Power Bl Visuals and Analytics @ Transform Data in Power B

Syntax for How to use Explained Syntax for How to use Explained
Time Series Use Line Charts, Gantt Charts, or Tracks and visualizes data trends Promote Home Converts the first row of data into
Analysis Area Charts over time, useful for identifying Headers Use First Row as Headers column headers.
disruptions or seasonal patterns.
Slicers Visualizations Pane Filters data interactively by Rename Queries Pane i Updates query names to make
Slicer Tcon « « categories such as time or Queries Right-click on Query i them meaningful and organized.
Add Field to Slicer § g geography, enabling segmentation Rename ] DAX Query
- of data. :
G i data ( Rename > Right-click on column Updates column names for clarity
- roups continuous data (e.g. T
Custom Bin DTSR FRINE PS 5 Columns > Rename OR Double-click column and organization of the dataset.
Groups Right-click Field « « numerical values or dates) into ot
< . 2 eader
New Group 2 £ equal intervals for better analysis.
a B > Enter new name
Set Bin Size 2
Replace > Transform Tab i Substitutes specific values or nulls
Quick Power BI Web Service Automatically generates insights ales > Replace Values R\L}]z Y\”th n?W On?S toresolve
Insights Report using machine learning algorithms, > Enter Value to Find and i inconsistencies or make values

DATAQUEST

More Options

Quick Insights

Power Bl Cheat Sheet

ideal for initial dashboard
exploration.

Remove Rows

Replace
> Close & Apply

Select rows
Home

Remove Rows
Remove Top Rows

user-friendly.

Deletes unnecessary rows to clean
the dataset and improve analysis
accuracy.




6’7 Transform Data in Power BI

Syntax for How to use Explained Syntax for How to use Explained
Remove > Select columns Deletes unwanted columns or Split Columns Home £ i Divides a column into two or more
Columns > Home retains only necessary ones. Split Column FI IW based on a specified delimiter (e.g.,
Split

> Remove Columns OR Remove Other By Delimiter column v comma, space).

Columns
Remove Right-click Column Header Eliminates duplicate values to Combine Add Column Merges multiple columns into one,
Duplicates Remove Duplicates ensure accuracy and uniqueness in Columns Custom Column == improving readability or preparing

Pivot Columns

Unpivot
Columns

DATAQUEST

Transform

Pivot Column

Select Value Column
Choose Aggregate Function

Select columns
Transform

Unpivot Columns

Power Bl Cheat Sheet

data.

Summarizes data by converting
rows into columns using aggregate
functions like SUM , COUNT , or
AVERAGE .

Converts column data into rows,
enabling easier analysis of wide
datasets.

Sort Columns

Group By

Custom
Concatenate values with Column

delimiter

Home
Sort Ascending/Descending
Choose column

> Transform

> Group By

> Select column(s)

> Define operation (SUM,
COUNT, etc.)

data for analysis.

Reorders data within a column
alphabetically, numerically, or by
other criteria.

Aggregates data based on selected
columns to perform calculations
like sums or counts.




6’7 Transform Data in Power BI

Syntax for How to use Explained Syntax for How to use Explained

Merge Queries Home - Combines data from multiple Change Select Column Fixes data type issues by selecting
Merge Queries queries into one using a join Column Data Trreneferm Talb the correct type for calculations
Choose Tables and Columns operation (e.g., INNER JOIN, Type Data Type and transformations.
Select Join Type OUTER JOIN). Choose Correct Data Type

Duplicate Right-click column Creates a copy of a column for Find View Tab Identifies irregularities or quality

Columns Duplicate Column further transformations without Anomalies Data Preview issues in data through visual

summaries like column statistics
and value distributions.

altering the original. Check Column Distribution,

Quality, and Profile

Transpose Transform Transform  Add column Switches rows to columns or
Data Transpose R & columns to rows for reformatting
:;—:;e;;t 5 ‘_E C;ul:d rows data- . .
Modify M W e ek Edits the underlying M code for
Code Advanced Ed-itor advanced or customized
Edit Code transformations.
Fill Down/Up Transform — Fills blank cells in a column with Click Done
Fill o1 i, values from the cell above or
Fill Down or Fill Up Up-. below.
Add Home Adds a new column based on
Conditional Add Column defined conditions (e.g.,
Columns Conditional Column categorizing data into ranges).
Combine Files Home T Consolidates data from multiple Define conditions and values

Combine Files 2 Append queries - files (e.g., Excel or CSV) into one
41 Combine files

Select Folder S query.
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% Workspaces and Security

Syntax for

Create a
Workspace

Assign
Workspace
Roles

Deployment
Pipelines

Lineage View

How to use

Power BI Service
Workspaces
Create a Workspace

> Workspace

> Access

> Add Email or Group

> Assign Role (Admin, Member,

Contributor, Viewer)

Power BI Service
Deployment Pipelines
Create Pipeline
Configure Workspace

Workspace
View Drop-Down
Lineage

DATAQUEST Power Bl Cheat Sheet

Explained

Enables you to organize and
collaborate on dashboards,
reports, and datasets.

Defines user permissions for
collaboration and content
management within the
workspace.

Manages content migration
between development, testing, and
production environments
(Premium accounts only).

Visualizes relationships between
workspace artifacts (reports,
datasets) and external
dependencies.

Syntax for

Usage Metrics

Sensitivity
Labels

Scheduled
Refresh

Promote and
Certify
Datasets

How to use

Workspace

Report

More Options

View Usage Metrics

Power BI Desktop
Apply Sensitivity Labels

Publish

Dataset

Settings
Scheduled Refresh

Power BI

Dataset

Promote or Certify

Service

Explained

Tracks performance and user
interaction metrics for reports and
dashboards.

Protects sensitive data by
specifying export permissions.

Automates data updates to ensure
reports and dashboards display the
latest information.

Endorses high-quality datasets for
organizational use, ensuring
reliability and consistency.




% Workspaces and Security

Syntax for How to use Explained Syntax for How to use Explained

Test RLS Roles > Power BI Desktop Simulates role-specific views to What-If Modeling Tab Runs scenario analysis by
> Modeling Tab verify correct implementation of Eo e e [Baraliem? dynamically changing parameter

row-level security. values (e.g., forecasting sales
impact with variable discounts).

> View as Roles Define Parameter

Create Measure

Gateways for > Install Power BI Gateway Connects on-premises data sources

On-Premises > Configure Gateway in Power BI to Power Bl cloud services, Manage Power BI Desktop Organizes data into fact and

Data Service enabling seamless data access and Semantic Create Relationships dimension tables for optimized
refresh. Models Define Star Schema performance and analysis.

Parameters Power Query Editor Enables dynamic filtering of
for Dynamic Manage Parameters reports based on user input or

Reports Create New Parameter predeflned values. Create
Replace Filter with Parameter Dynamic

Dynamically changes calculations
in reports based on input
parameters.

DAX: Measure = SUM(Data[Field]) *

Parameter[Value]

Measures
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